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DNG File Format

In this lesson, were going to talk about the DNG file format. The format has been 
around since 2004 and the information relating to it can often times seem con-
fusing. The lesson will cover what the DNG format is, the advantages, disadvan-
tages, etc. The goal is that you become knowledgeable about it enough to know 
whether or not it is a good format for you to use with your images. 

Basic Info

• DNG = Digital Negative

• The format was introduced by Adobe in 2004.

• It’s a fully documented format, submitted to the 
standards organization.

• Some cameras can save directly into the DNG 
format.

• You can save a file from raw into DNG without 
a heavy conversion, so it maintains the special 
qualities of a raw file. 

• What’s nice about the format is that you can take a raw file from almost any 
camera manufacturer and convert it into the DNG format. When you do this, 
it preserves the information in the file without changing it all that much. That 
can’t be said for other formats. When you convert a raw file to jpg, png, etc., 
the file goes through a pretty radical transformation, and some or much of 
the raw information is lost. When you lose information in the file, you can not 
effectively edit the image and maintain high quality results.

• You can open a DNG file in older software like Photoshop CS6 or Lightroom 6. 
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Cameras that save into DNG

The following camera brands can save directly into the DNG format within the 
camera itself:

• Leica

• Hasselblad

• Pentax

• Ricoh

• Samsung

• Casio

It would be nice if all major camera brands saved images in the DNG format. This 
would prevent us from having to update our Adobe software every time we use 
a new camera. We need to do this because, with every new camera release, the 
camera company makes small changes to their individual raw file format and 
then Adobe needs to update the software in order for it to be compatible. 

Advantages of the DNG file format

• It preserves camera data similar to a raw file.  (Note: True raw is unaltered)

• New raw formats in DNG can be opened in older software.

• There is no need for XMP files. With raw files, the adjustments made in Light-
room or Camera Raw are saved alongside the image file as a separate “side-
car” file known as an XMP file. With the DNG format, that information can be 
saved directly into the file. 

• With DNG, you get files that are 10-20% smaller.  The data that the camera 
sensor captures into your normal raw files doesn’t have any kind of efficient 
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compression. DNG has some compression, making the file size a bit smaller. 

• The lossy version is up to 75% smaller. There is a version of the DNG format 
where you can choose to use lossy compression. With this version, the quality 
of the file will go down, but it will also be up to 75% smaller than the original 
file size and this can be useful for some purposes. 

• DNG files have an embedded preview that can be updated. In a normal raw 
file, the built-in preview is a jpg file that can not be changed. With a DNG file, 
the preview built into the file changes to reflect any adjustments you make to 
the image.  This means that if I preview the DNG file in other software, it will 
preview the changes that I made within Lightroom or Camera Raw. 

• DNG files have a checksum for validation. This means that the DNG format 
assigns the file a number and that number would change if any data in the file 
changed. With this, you can look back at your old files and ask it to validate 
them based on those numbers. If the checksum number is different than the 
number it had on record, that means that something happened with file. This 
means that, with DNG, we can validate that our files have not changed and 
become corrupt. 

Disadvantages of the DNG format

• The conversion is not reversible (unless you embed the full raw file).

• Nikon/Canon/Sony, etc. software can’t open DNG files. 

• Updating a backup is more data-intensive compared to if you were using XMP 
files. When you make changes to a raw file, those changes are saved as a sep-
arate XMP file, which is a super small text file stored alongside the image file. 
When you back up these files, the small XMP files are the only ones that need 
to be saved. With the DNG format, those changes are saved within the image 
file itself. When backing up these files, it will take much longer because the 
entire image file needs to be saved, not just the small XMP text file. 
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• File info date is the conversion date, not the capture date. It’s important to be 
aware that when you convert an image from a raw format into a DNG format, 
the file date will reflect the date the image was converted to into DNG and not 
the date you captured the image with your camera. 

• It takes time to convert images into the DNG format.

• Some metadata is lost when you convert to DNG. It’s very negligible, but there 
have been some reports of small amounts of metadata being lost when con-
verting (ex: focus points). 

• Some photography competitions require raw files, not DNG.

When to use DNG

• HDR & Panos from ACR/LR Whenever you use Camera Raw or Lightroom to 
combine multiple images into a panorama or an HDR composite, the default 
file format of the resulting file is DNG and that’s because it can maintain many 
of the special qualities of a raw file (ability to bring back shadow/highlight 
detail, etc.). 

• Old software, new camera (Photoshop CS6, Lightroom 6) If you are using 
older software, that software may not be able to support the file formats saved 
by newer cameras. If this is the case, you can convert the files to DNG so that 
older software can support them. 

• Deliver “Raw” file to client  If a client asks for a raw file, it isn’t always ideal 
to send them the image file PLUS the sidecar XMP file that contains all of the 
adjustments. Additionally, the client may not need the huge file size of the raw 
file. With DNG, there is no XMP file and the file size can be scaled down while 
still retaining the qualities of the raw file. 

• Teaching with smaller files  DNG files can be convenient for teaching purpos-
es. In fact, Masters Academy uses DNG files as “raw” files.”
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• Lossy DNG for outtakes If you would like to save space on your hard drive and 
have a folder designated as your outtakes folder, you can use the DNG format 
for these images, as they’re 1/4 the size of raw format originals. 

• Can use lossy DNG as an alternative to jPEG This will allow you to dramatically 
reduce the file size while retaining more information in the file. Note that this 
is fine as long as you’re not going to give the file to someone else. When you 
give a file to someone else, it should be in a universal file format that just about 
any software can open. 

Notes about DNG

• DNG support in other software does NOT mean that software will reflect the 
ACR/LR edits. That’s because the adjustments made in ACR and/or Light-
room are stored in the metadata, not the image itself. When software says it 
supports DNG, it means that it can open a file that has been saved in the DNG 
format. 

• Converting from jpg to DNG can be validated, but the file size will still increase 
and quality can decrease.  Converting from jpg to DNG also means that the 
format is no longer universal, as DNG is not compatible with as much software 
as the jpg format.

• DNG is better than jpg for raw captures that don’t need to be high resolution 
or in a universal file format.

How to convert to DNG

Now let’s talk about how we can convert images into the DNG format. We already 
mentioned that some cameras are capable of saving images in DNG and in those 
cases, we wouldn’t need to convert at all. We’d just need to tell our camera to 
save that format. If that’s not the case, there are five options to choose from.
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Camera Raw via the Save button In Adobe Camera Raw, there is a Save button 
in the lower left corner of the interface. When you click it, you can choose from 
various file formats, one of which is DNG. I would use this option if I was using 
ACR and not using Lightroom at all. 

Lightroom during import  When importing images into Lightroom, there is a 
setting that allows us to convert to DNG. Note that you can’t convert newer raw 
formats with an older version of Lightroom. (You would have to use a DNG con-
verter instead.)  

In Lightroom’s Import dialog, clicking the Copy as DNG option will cause Lightroom to copy 
the files from their current location and convert them into DNG files in a new location that you 
specify. 
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If you use this method for importing DNG files, there is a group of settings you 
should be aware of. Go to the Lightroom menu and choose Preferences (In Win-
dows, this would be found under the Edit menu.) and then click on the File Han-
dling tab within the Preferences dialog. Here, you’ll find a section called Import 
DNG Creation. This will give you options regarding the file extension, compatibil-
ity versions and JPEG previews. 

In the Lightroom Preferences, you can specify the software compatibility for DNG files. If you 
hover your cursor over an option in the menu, a box will pop up, listing all of the compatible 
software. 
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Lightroom during export When exporting an image (or images) from Lightroom, 
the file format options within the Export dialog include DNG. This method can be 
convenient when you need to hand off an image to someone who wants the raw 
file.  Within the Lightroom Export dialog, click on the File Settings tab to access 
the File Format menu. If you choose the DNG format, a series of settings related 
to it will become available. Included here is a “Use Lossy Compression” check box. 
If you turn this on, your file size will be smaller. If you don’t turn this check box on, 
then the Image Sizing settings will be grayed out/unavailable. That’s because it 
will use the full size image when exporting as DNG. If you do turn the check box 
on, you can specify the size based on the long edge of the image or in megapixels.

Within the Lightroom Export dialog, click on the File Settings tab to access the File Format 
menu. If you choose the DNG format, a series of settings related to it will become available.
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Lightroom Library Module  In Lightroom’s Library Module, you can select an 
image (or images), go to the Library menu at the top of the screen and choose 
Convert Photo to DNG. 

Adobe DNG Converter This is a special program that you can download for free 
from the internet. This is what you would use if you have older software that 
does’t support the camera’s newer raw format. 

DNG Versions

When exporting to DNG, you may be given the option of different DNG versions 
to choose from. These options are based on what version of Camera Raw would 
be able to open the file. 

• Camera Raw 2.4, Photoshop CS & Lightroom 1.0 (or newer)

• Camera Raw 4.1, Photoshop CS3 & Lightroom 1.1 (or newer)

• Camera Raw 4.6, Photoshop CS3 & Lightroom 2.1 (or newer)

• Camera Raw 5.4, Photoshop CS4 & Lightroom 2.4 (or newer)

• Camera Raw 6.6, Photoshop CS5 & Lightroom 3.6 (or newer)

• Camera Raw 7.1, Photoshop CS6 & Lightroom 4.1 (or newer)

Validating DNG files

Earlier in the lesson, we talked about the checksum concept, which is the ability 
to check for changes in a file to see if it has somehow become corrupt. You can 
run this “check” by selecting one or more DNG files in Lightroom, going to the 
Library menu at the top of the screen and choosing Validate DNG Files. You will 
see a progress bar at the top of the screen, indicating that Lightroom is checking 
the files to make sure that they haven’t become corrupt. 
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The DNG Converter

As was mentioned above, the DNG converter is a piece of free software and you 
can find it by doing a Google search for “Adobe DNG Converter download.”  Once 
open, you’ll find a list of options, the first of which is where you select the folder 
of images you’d like to convert. If the folder you selected has subfolders con-
taining images that need to be converted as well, turn on the “Images contained 
within subfolders” check box. There is another check box where you can tell it to 
“Skip source image if destination image already exists” and this will ensure that 
you don’t convert an image twice and therefore have two copies of it in the des-
tination folder. I usually keep 
this setting turned on. The 
next menu will allow you 
to determine whether the 
new files should be saved 
into the same location or 
into a new location. If you 
choose to save into a new 
location, you’ll be prompt-
ed to choose that desti-
nation folder on your hard 
drive. Next, you can decide 
whether you’d like the file 
names to stay the same or if 
you’d like to designate new 
names. Lastly, there is a list 
of all the DNG file prefer-
ences. If you want to change 
them, click on the Change 
Preferences button and 
you’ll be presented with the 
same options that we saw in 

The Adobe DNG Converter can be downloaded for free. 
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the Preferences dialog. When you’re done working through the settings, click the 
Convert button in the bottom right. A Conversion Status dialog will appear, show-
ing you the progress and listing any problems that occur. A problem may occur if 
you include an image that is not a raw file. 

Converting to DNG in Camera Raw

You can save a DNG file from ACR as well. With an image open in ACR, click the 
Save Image button in the lower left corner. The Save Options dialog will appear 
and you’ll set the Format menu to Digital Negative. The DNG settings will appear 
below that menu so you can work through those and then click Save. 

In Adobe Camera Raw, click the Save Image button to bring up the Save Options and choose 
DNG from the Format menu. 
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Updating DNG files

We mentioned earlier that DNG files have previews built into them. In ACR or 
Lightroom, that preview may not be automatically updated. If you plan on view-
ing the previews outside of Adobe software, you will have to manually tell it to 
update the preview. 

Updating Embedded Preview:

• Camera Raw: Click on Hamburger menu 
and choose to Update DNG Previews

• Lightroom: Go to the Metadata menu and 
choose Update DNG Preview & Metadata

Updating Lightroom Develop settings, keywords, labels, etc. (Catalog —> DNG):

• Update Preview & Metadata: Click on the Metadata menu and choose to Up-
date DNG Preview & Metadata

• Update Metadata only: Click on the Metadata menu and choose Save Metada-
ta to file (or Command+S) 

Tips & Tricks on working with DNG files

• If you ever use smart previews in Lightroom, know that those are actually lossy 
DNG files that are 2,560 pixels wide. When I’m traveling and don’t have the 
large hard drive that contains all of my images, I make sure that the images I 
know I’ll be using have smart previews and can therefore be exported as DNG 
files. Just know that the quality of this export will not be as high as if you had 
the hard drive containing the images actually attached. 

• If you are converting your images to DNG as you import them into Lightroom, 

The hamburger menu in Camera Raw
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I’d recommend validating those files immediately afterward to ensure that ev-
erything converted properly and that nothing became corrupt in the process. 
To do this, select the images, go to the Library menu and choose Validate DNG 
Files. 

• Validate the backup of your images. The following technique will teach you 
how to validate the backup of your images to ensure that no files have become 
corrupt. Make sure that your backup drive is connected to your computer in-
stead of your main image drive. In Lightroom, go to your folder list on the left 
side of the interface. You want to locate the name of the hard drive containing 
your images. In the video example, that drive was not immediately visible so 
we right-clicked on one of the folders and chose “Show Parent Folder” from 
the menu that popped up. I kept doing this until the name of the hard drive 
appeared. Right-click on the name of the hard drive, choose “Find Missing 
Folder” from the menu that pops up and then direct it to your backup drive. 
You can then select all of the images, go to the Library menu and choose Val-
idate DNG Files. 

• If you ever find that you’re working with older software that is supposed to 
support DNG, but for some reason it doesn’t, here’s something you can try. 
When initially converting your images into DNG, use the linear option, which 
can be done as follows. Open the DNG converter and click on the Change Pref-
erences button in the lower right. When the preferences dialog appears, click 
on the Compatibility menu and choose Custom. A box will pop up, inside of 
which you will turn on the Linear checkbox and click OK. 


